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Over 5 trading days as at yesterday www.shareinvestor.com | market data at your fingertips
ten-by-st 1. mouse over Ranking > select Top Active > mouse over Column Layout > select Column Layout > select Edit Customs > select Name > select Last Done Price >
SHAREINVESTOR SIED-DY-Step Edit Customs > select Name > select Volume > select Last Done Price > Mouse select 5 Days Change > select 5 Days % Change > Mouse Over Column Layout >
WEBPR® GUIDE Over Column Layout > select Custom select Custom
2. mouse over Ranking > select Top Turnover > mouse over Column Layout > 4. mouse over Ranking > select Top Losers (Over 5 Trading Days)
Sharelnvestor WebPro (www.shareinvestor.com) ﬁAeclicsteEg\‘/teg%soﬂr%Sn Igiloeuctt>N§dnlef:: ngls?gtmLaSt Done Price > select Value > S mouse over Ran:jng g Se:ed Top :/0 Gainers (Over 5 Tradqmg Days)
Prices > Stock Prices > SGX > click Stocks tab 3. mouse over Ranking > select Top Gainers (Over 5 Trading Days) > mouse over 8, st evel Relniing > Selisei Vo 6 Losizrs (Qver & ieling L)
Singapore Top Actives Top Gainers Top Losers
(as at yesterday) (over 5 Trading days as at yesterday) (over 5 Trading days as at yesterday)
Name Last Done Volume Name Last Done 5 Days Chg Name Last Done 5 Days Chg
Seatrium 0.108 193,506.70 LiNing 5xShortSG240327 6.010 3.54 PetroCH 5xLongSG241030 2.270 2.59
SMI Vantage”® 0.055 4595210 SPDR S&P500 US$ 426.250 2.25 PHILLIP MM S$ 103.244 -0.92
HSI 16200MBePW231228 0.066 43,495.00 GLD US$ 184.300 1.51 uUoB 26.930 -0.79
Ley Choon 0.037 42,797.90 IFAST 6.730 1.21 XT Vietnam US$ 25.150 -0.65
Eneco Energy” 0.008 30,128.40 SPDR DJIA US$ 334.960 1.18 Powermatic Data 2.350 -0.50
HSI 18200MBeCW231129 0.040 27,925.80 NC22300W 720801 91.000 1.00 DBS 32.660 -0.49
Genting Sing 0.865 25,890.40 GLD SG$ 251.180 0.83 XT MSINDO US$ 14.610 -0.49
YZJ Shipbldg SGD 1.490 23,028.30 JMH USD 40.980 0.73 BYDElec 5xLongSG231220A 0.730 -0.48
Frasers L&C Tr 1.080 21,096.50 Jardine C&C 29.100 0.66 UOB 5xLongUB250530 1.415 -0.43
ThaiBev 0.540 20,895.40 LiNing 5xShortUB250321 3.600 0.59 NIO Inc. USD OV 7.480 -0.40
Singapore Top Turnover Top % Gainers Top % Losers
(as at yesterday) (over 5 Trading days as at yesterday) (over 5 Trading days as at yesterday)
Name Last Done Value Name Last Done 5 Days % Chg Name Last Done 5 Days % Chg
DBS 32.660 109,758,553.00 Baidu 5xShortSG231220 0.015 400.00 SinoBio 5xShortSG231220 0.016 -62.79
CapLand Ascendas REIT 2.670 42,599,512.00 AP Strategic 0.002 100.00 Xiaomi 5xShortUB250321 0.022 -56.00
Singtel 2.430 39,109,538.00 Asiatic 0.002 100.00 Xiaomi 5xShortSG231220 0.016 -54.29
YZJ Shipbldg SGD 1.490 33926,017.00 CapAllianz 0.002 100.00 PetroCH 5xLongSG241030 2.270 -52.90
OCBC Bank 12.700 32,574,751.00 Xiaomi 5xLongUB250228 0.030 87.50 SIA MB eCW231215 0.006 -50.00
CapLand IntCom T 1.800 32,170,781.00 Xiaomi 5xLongUB250930 0.600 73.91 Southern Arch 0.001 -50.00
CapitaLandinvest 2.950 30,988936.00 HSBC 5xShortSG241213 0.018 63.64 NASDAQ 16000MBeCW231215 0.053 -43.01
Mapletree Log Tr 1510 23,403,185.00 CSPC 5xLongSG231102 0.015 50.00 OCBC Bk MB eCW231124 0.033 -40.00

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for
damages resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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Over 5 tradlng days : SHAREINVESTOR Sharelnvestor WebPro (www.shareinvestor.com)

WEBPR® . Price > Stock prices

step-by-step . select Market: Bursa / HKEX / NYSE / NASDAQ (one bourse at a time)

. select Stocks Tab

. select Ranking Top Gainers or Top Losers (Over 5 Trading Days)

. Mouse over Column Layout > select Edit Customs > select Name > select Last Done Price > select 5 Days
Change > select 52 Weeks High > select 52 Weeks Low > Mouse Over Column Layout > select Custom

< GUIDE

a b wnNn =

BURSA

MARKETS

Top Gainers Top Losers

Name Last Done CiaD:;: 52 W;eilg(: & WeLeok; Name Last Done CshaD:!g,: 52 Wiﬁ;ﬁ 2e Wef:;
IHS046000824 102.100 1.300 102.500 97.900 NESTLE 122.900 -3.700 140.600 120.100
ALLIANZ-PA 16.960 0.360 17.800 13.120 DIN045801028 102.700 -2.100 104.800 100.660
RAPID 26.600 0.340 26.800 14.320 HEXTECH 23.600 -1.000 30.600 10.100
YTLPOWR 2.290 0.290 2.240 0.660 MPI 25.980 -0.800 34.980 23.820
YTLPOWR-C28 0.910 0.250 0.850 0.085 HAPSENG 4.720 -0.580 7.400 3.030

Top Gainers Top Losers

5 Days 52 Weeks 52 Weeks 5 Days 52 Weeks 52 Weeks
Name Last Done Change High T Name Last Done Change High e
NOAH HOLDINGS PRIVATE WEALTH AND AS 187.200 169.180 187.200 17.500 YUM CHINA HOLDINGS INC 350.000 -64.200 514.500 346.000
BOSERA ASSET MGT (INTL) CO LTD USD MON- y
EY MARKET ETE HKD 7,939.100 19.050 7,928.050 7,811.050 YSB INC 19.080 27.570 64.500 19.000
SPDR GOLD TRUST GOLD SHARES NPV 1,439.500 12.500 1,498.000 1,190.000 XTRACKERS NIFTY 50 SWAP UCITSETF 1C 1,722.500 -18.500 1,827.500 1,549.500
CHINA INTL CAP CORP HK ASSET MGMT ICBC
CICC USD MONEY MARKET ETF 8,562.150 10.300 8,562.150 8,115.350 BYD COMPANY LIMITED 232.000 -9.400 280.600 165.100
EVEREST MEDICINES LTD 31.200 8.350 31.150 6.410 XTRACKERS FTSE VIETNAM SWAP UCITS ETF 197.200 -9.200 251.500 175.000

NYSE

Top Gainers Top Losers

Name astoone G2 Ve Ve e stoone - GDwe SMome Ve
BERKSHIRE HATHAWAY INC 523,749.000 13,624.000 566,569.970 426,136.000 PAYCOM SOFTWARE INC 150.690 -94.250 374.040 146.880
CHIPOTLE MEXICAN GRILL 1,986.640 180.170 2,175.010 1,344.050 KINSALE CAPITAL GROUP INC 343.150 -83.070 457.730 250.895
NVRINC 5,560.550 133.730 6,525.000 4,027.040 BOSTON BEER CO INC 330.780 -34.100 420.835 296.270
DECKERS OUTDOOR CORP 593.980 109.400 598.950 326.100 CHART INDUSTRIES INC 114.840 -31.740 242.585 101.440
SERVICENOW INC 593.480 42.530 614.360 351.250 ESTEE LAUDER COMPANIES INC 104.510 -29.720 283.623 102.220

NASDAQ

Top Gainers Top Losers

Name Last Done ci::;: 52 wﬁ?;ﬁ 52 Wef:; Name Last Done ci::;: 52 w;?lg(: 52 Wef:;
MERCADOLIBRE INC 1,300.010 125.010 1,451.560 815.855 FIRST CITIZENS BANCSHARES INC NRTH 1,356.120 -58.350 1,512.070 505.840
MONOLITHIC POWER SYSTEM INC 456.560 52.500 595.980 328.200 SAREPTA THERAPEUTICS INC 76.520 -35.080 159.890 55.250
ADOBE INC 544.500 30.220 574.400 278.230 REALPHA TECH CORP 17.500 -28.500 575.410 18.300
ARCBEST CORP 114.390 26.400 122.860 68.000 ENPHASE ENERGY INC 76.730 -19.450 339.920 76.060
BROADCOM INC 852.940 26.190 925.910 441.360 ON SEMICONDUCTOR CORP 64.840 -17.950 111.350 58.430

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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SE=S T S STOCK MARKET DATA
~ _® AT YOURFINGERTIPS

=t Powerful browser-based market analytics platform.
B Access from anywhere

......

©
Portfolio
Management
© » Profit & Loss Summary
8 Markets Data > Stock Alert
P Get access to data from » News & Events filtering

Bursa, NYSE, Nasdagq,
HKEX, SGX, IDX, SET & ASX

@ Fundamental Analysis @

@ » Customizable column layout

Financial Analysis ® ® © FactSheet
@ Statement > Key Stock Information ()

» Profit & Loss T h . I B k y » Ownership

» Balance Sheet © ec n-lca © FOKErS » Consensus Estimates
Chartlng ca" » Annual Report

» Cash Flow Statement » C? chart (Customisable & ® o .

» More than 20 Financial Ratios Comprehensive) o » Historical Price

» Dividend Analysis gﬂrll‘ISIC Value » Insider Trades

alculator

What’s new on WebPro (stable Release 12.1.0)

In our effort to keep our platform at the forefront of trading technology, we have added on some
new features onto our C2 Chart in WebPro

ADDITIONAL NEW FEATURES:
Anchor selector for AVWAP, PVAT, and PAV indicators
Volume profile indicator by date range
Moving Average Cross indicator
Guppy Multiple Moving Average (GMMA) indicator
GoNoGo Trend Signal indicators
SignallQ

So what are you waiting for? Head to our platform today and check out our new trading chart
features and indicators. We're confident that you'll love the improvements we've made and that
they'll help you become a more successful trader.

Click here to start your 9 days FREE trial
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Dividend Stocks (as at yesterday)

for weekly InveSt @
(&]
DEFINITION Company is paying out dividend with low or moderate leverage. o
-
CHART GUIDE  Total Shareholder Return (TSR) combines share price appreciation and distributions paid to show the total return to the shareholder expressed as a percentage. (2]
Sharelnvestor WebPro > Screener > Market Screener + Fundamental Analysis Conditions tab >select (v) Total Shareholder Returns 6. CAGR of Dividend Per Share - select (less than) type (30)
SHAREINVESTOR (FA &TA) > select SGX > add criteria + Fundamental Analysis Conditions tab / >select (vi) CAGR of Dividend Per Share % for the past select (5) financial year(s)
WEBPR®) A. Criteria - Fundamental Analysis Conditions tab >select (vii) CAGR of Dividend Per Share 7. CAGR of Dividend Per Share - select (more than) type (1)
step-by-step > click Add Criteria B. Conditions (Criteria Filters) % for the past select (5) financial year(s) »
+ Fundamental Analysis Conditions tab >select (i) 1. Dividend Yield - select (more than) type (1) % for the past select (1) financial year(s) > click Save Template > Create New Template type (Dividend
Dividend Yield 2. Dividend Payout (Historical) - select (between) type (0.5) to type (1) times for the Companies) > click Create o i
Fundamental Analysis Conditions tab >select (ii) past select (1) financial year(s) > click Save Template as > select Dividend Companies >
Dividend Payout (Historical) 3. Total Debt to Equity — select (less than) type (1) for the past select (1) financial click Save _
Fundamental Analysis Conditions tab >select (iii) year(s) > click Sgreen Now (may take a few minutes)
Total Debt To Equity 4. Total Shareholder Return — select (more than) type (5) % for the past select (3) > Sort By: Select (Dividend Yield) Select (Desc)
Fundamental Analysis Conditions tab >select (iv) financial year(s) > Mouse over stock name > Factsheet > looking for Total
Total Shareholder Returns 5. Total Shareholder Return — select (more than) type (5) % for the past select (5) Shareholder Return

financial year(s)
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(NO8.SI)
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Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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SHAREINVESTOR

STATION

©® 8 Markets Data © Dynamic Chart

» Get access to data from Bursa, NYSE, Nasdag, » Candlestick Pattern Recognition

HKEX, SGX, IDX, SET & ASX » 111 Indicators

» 39 Drawing Tools
» Performance Comparison Chart

© Intraday Data © Market Screener
» Market Depth 4 ?_2 cgteria rangirlwzgtfrorrl FA, @ Power Frame

» Trade Summary Matrix & Chart .
» Times & Sales > Real-time Data » Combining few Dynamic
Charts together with intraday

> Intraday Market Ticker . o
information in one frame

© © O, © ©,
Technical Analysis

o Fundamental Analysis o

©  Financial Analysis FactSheet ©
Statement b Key Stock Information
» Profit & Loss » Ownership
» Balance Sheet Start your 18 dayS T b Consensus Estimates
» Cash Flow Statement FREE tri a| now - i » Annual Report
» More than 20 Financial Ratios » Historical Pri
» Dividend Analysis (Valued at SGD$52 40) E {;? > In;;ercjradeze
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Fundamental Analys

Growth Stocks (as at yesterday)

DEFINITION Company revenue is growing and making good quality of earnings with positive Free Cash Flow.

for weekly InveS$t

STOCKS

CHART GUIDE Total Shareholder Return (TSR) combines share price appreciation and distributions paid to show the total return to the shareholder expressed as a percentage.

Sharelnvestor WebPro > Screener > Market Screener B. Conditions (Criteria Filters) > click Save Template as > select Growth
SHAREINVESTOR (FA & TA) > select SGX > add criteria 1. Free Cash Flow — select (more than) type (1) for the past select (1) financial year(s) Companies > click Save
WEBPR@ A. Criteria 2. Revenue Growth — select (more than) type (1) for the past select (1) financial year(s) > click Screen Now (may take a few minutes)
step-by-step 1. Fundamental Analysis Conditions tab >select (i) 3. Gross Profit (Earnings) Margin - select (more than) type (30) % for the past select (1) > Sort By: Select (Revenue Growth) Select
Free Cash Flow, (ii) Revenue Growth, (iii) Gross financial year(s) _ (Desc)
Profit (Earnings) Margin, (iv) Quality of Earnings 4. Quality of Earnings — select (more than) type (1) for the past select (1) financial year(s) > Mouse over stock name > Factsheet >
(v) Total Shareholder Returns 5. Total Shareholder Return — select (more than) type (5) % for the past select (3) financial looking for Total Shareholder Return
> click Add Criteria year(s) )
2. Fundamental Analysis Conditions tab >select 6. Total Shareholder Return — select (more than) type (5) % for the past select (5) financial
(vi) Total Shareholder Returns year(s) , ,
> click Add Criteria > click Save Template > Create New Template type (Growth Companies) > click Create

MarcoPolo Marine Ltd.
(5LY.SI)

Larg Term Ratum

Genting Singapore Limited
(G13.51)

adnsm Term Aetum

At Rtm

Grand Banks Yachts
Limited (G50.SI)

Mhreiagm v Helan
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Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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COMPANY ANALYSIS AT YOUR FINGERTIPS

Click the Analysis buttons to access the Factsheets of
any company featured on the Hot Stocks (TA),

Momentum-Up (TA), Up-Trending (TA), Dividend (FA),
Growth (FA) & Value (FA) Stocks pages.

Invest,with knowledge
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Fundamental Analysis

Va I ue Stoc kS (as at yesterday) for weekly InveS$t

DEFINITION Share price of a company trading at a lower price as compared to its fundamentals (FA) such as financial performance and dividend, allowing it to be attractive to value investors.

STOCKS

CHART GUIDE Total Shareholder Return (TSR) combines share price appreciation and dividend distributions paid to show the total return to the shareholder expressed as a percentage.

Sharelnvestor WebPro > Screener > Market Screener (FA & TA) > select SGX B. Conditions > click Save Template > Create New Template type
SHAREINVESTOR > add criteria 1. Price Earnings Ratio — select (less than) type (15) times (Value Stock) > click Create
WEBPR@ - now > click Save Template as > select Value Companies >
step-by-ste A erterla o 2. CAGR of Net Earnings — select (more than) type (10) % click Save

p-Dy-Step >click Add Criteria » o ) , for the past type (3) financial year(s) > click Screen Now (may take a few minutes)
» Fundamental Analys!s Cond!t!ons tab (i) Price Earnlngs Ratio ) 3. Net Debt To Equity — select (less than) type (1) for the > Mouse over stock name > Factsheet > looking for
+ Fundamental Analysis Conditions tab >select (i) CAGR of Net Earnings past select (1) financial year(s) Total Shareholder Return
Fundamental Analysis Conditions tab >select (iii) Net Debt To Equity 4. Return On Equity (ROE) - select (more than) type (10) % > Mouse over stock name > Charts > click C2 Charts tab

Fundamental Analysis Conditions tab >select (iv) Return On Equity (ROE) for the past select (1) financial year(s)

/leﬁ\.Cﬁ China Intl HIdgs Ltd.

l/%ﬂ"m (BEH.SI)

Lang Tarm Retam

/leﬁ\,ﬂ Samudera Shipping

m Line Ltd. (S56.SI)
|

Torts S ehaecaed Satam

Brusel fqrem Haban

Lang Term Ratem

/Iclx.lfl]\,vl’l Fuji Offset Plates Mfg Ltd
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|
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Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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COMPANY SPOTLIGHT

A Stock with Dividend Growth of 40%
and Strong Revenue Growth on SGX

Vincent Wong, Investor-One / Tue, Oct 31, 8:00 PM

s
B -

Our recent focus on the article, 5 Stocks with Earnings Growth over 20%
and a Dividend Yield Above 5% brought Audience Analytics (SGX: 1AZ)

to the forefront. A quick look at its recent financial numbers shows some
really good earnings growth and a decent dividend yield. This suggests that
Audience might be a consideration for those looking for growing dividends.

S$ (million) 1H2023 1H2022 y-0-y % change
Revenue 3.59 1.93 86.1%
Gross Profit 1.69 0.74 128.2%
Gross Profit Margin 47.1% 38.4%

Net Profit 0.59 0.06 845.3%

Net Profit Margin 16.4% 3.2%

In a previous article, we talked about our 5 Investment Checklist Items,
which we believe can be helpful for investors. Now, let's use Audience as

continued on next page...
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continued... [A Stock with Dividend Growth of 40% and Strong Revenue Growth on SGX]

an example and see how the company measures up against this checklist.
Ready to dive in? Let's see how the stock stacks up!

- Business Impact & Awards: Think of this as a school's award ceremony,
but for businesses. They then rank their clients, using surveys and other
tools, to decide amongst the sponsors who gets the top prizes at their
business awards. They host these awards in many countries across Asia,
with some of their notable awards being the SME100, HR Asia Awards,
and the Golden Bull Award. It is their main business that accounts for a
majority of its revenue.

 Exhibitions: Ever been to a career fair? You could've already attended
what Audience organizes. They set up events, and companies can
sponsor to be a part of it.

« Business Media: They've got digital and print brands that offer business
news and insights. So, if you're a business professional in Asia, you might
read one of their publications like SME Magazine or HR Asia. Additionally,
they host events where business folks can mingle and network, like the
SME CEO Forum.

The business is understandable. All these segments serve various needs
but could serve the same client base.

Read Also: Analyst Alert: Research Reports On SGX Listed REITs & Stocks

Not proven yet because of the short-listed period.

The business landscape they are in has a low barrier of entry in the sense
that starting such a business doesn't require a massive initial investment,
deep technical expertise, and, Intellectual Property. This means any new
player in the media business could jump in and challenge Audience’s
business recognition segment.

continued on next page...
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However, businesses that hand out awards thrive on legacy and reputation.
From what we've seen, their primary competitors in this arena are big
names like SPH and Fortune. Sure, institutions like Reuters, Bloomberg,
S&P, and even banks such as DBS and OCBC could step into the ring. But
what likely holds them back is that this sector is quite niche. For such large
entities, the effort might just outweigh the benefits.

Nonetheless, the business still commands a good gross margin (64%) and
net profit margin (40%). That should pass the checklist.

The rising Return On Equity (ROE) suggests that the profits they're retaining
are yielding solid returns. Their strategy for overseas growth seems to be
paying off. What stands out is that they're achieving this growth without
incurring hefty costs, a clear sign of adept management at the helm.

While a significant portion of their revenue typically rolls in during the
second half of the year because of the seasonality of business events,
they've managed to show impressive growth in the first half.

Group
6 Months Ended
Revenue 30 June
2023 2022
S$ S$

(unaudited) (unaudited)
Singapore 5,042 227,509
Malaysia 1,010,787 1,226,915
Hong Kong 804,250 105,426
Taiwan 246,976 172,117
Indonesia 485,776 106,217
Cambodia 972,581(" 2,965
Others 68,264 90,265
Total 3,593,676 1,931,414

continued on next page...
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So far, the management has consistently delivered on their promise, paying
out half of their profits. This not only reflects the management's dedication

to their word and shareholder value but also indicates that the business has
a healthy cash flow and isn't heavily reliant on capital.

Dividend Payout Ratio has been consistently above 50% previous 2 financial year

As of 30 June 2023, Audience boasts S$15 million on their balance sheet.
When you stack that against their market cap of S$45 million, a whopping
30% of the company's value is in cash.

Read Also: Seatrium Unveiled: Expert Insights on Temasek's Offshore
Powerhouse

On 30 Oct 2023, the trailing P/E ratio for the company stands at 7.2, but when
you factor in the net cash, it drops to a mere P/E ratio of 4.8. In addition to
that, they currently have a dividend yield of around 6%. Considering their
historical growth rate, the business seems to be quite the bargain.

To be conservative, let's leave out the net cash in our DCF analysis. We
employed the discounted cash flow model, using the company's Free Cash
Flow Per Share from the last financial year, which stands at SS0.04145.
Factoring in a 5% growth rate for 5 years and a discount rate of 10%, our
calculated intrinsic value is 50 cents per share. This contrasts with the 26
cents per share as of 30th October 2023.

Intrinsic Value

SGD 0.509

continued on next page...
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Thanks to their robust cash flow, and the asset-light nature of its business
model, as mentioned, Audience sits comfortably with a large net cash
position. With virtually no debt and a cushion of net cash, it's tough to
imagine them facing financial difficulties.

Based on the intrinsic value calculation, there's a +47.97% upside as
compared to the trading price on 30 Oct 2023. The high net cash, along
with the high upside provide a good margin of safety for the company’s
investors.

Margin of Safety

+47.95%

Undervalue

The stock is notably illiquid, leading to potential price volatility. On any given
day, the trading price can dip significantly, even with a limited number of
stocks being traded. For those with a hefty cash reserve, getting in can be
challenging. So, it's essential to approach this stock with patience and only
consider buying if you're in it for the long haul

The management has openly indicated that we might see some pressure on
gross margins in the upcoming report, mainly due to rising labor costs—a
challenge that isn't exclusive to Audience. However, it's worth noting that
this business has historically been steady. Even during the unpredictable
stretch from 2020 to 2022, they managed to expand. It seems unlikely that
they'll face any major operational disruptions in the near future.

Learn how to identify Hot Stocks using Technical Analysis (TA) and Fundamental Analysis (FA)
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Curated and managed by the Investor-One team under Sharelnvestor,
this free-to-access portfolio will feature local small and mid-cap companies
within Singapore Exchange’s Mainboard and Catalist.

Join us on the journey and watch as we manage a locally vested portfolio
with a fund of $100,000.
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Niscover Growing Companies

Investor-One Portfolio

Curated by Investor-One team, this portfolio features growing small and
mid cap companies within Singapore Exchange Catalist and Main Board.

The criteria for the companies are selected based on the following
metrics, with further evaluation on qualitative factors like management
team and growth prospects:

Portiolic Yield va |S8F 800 ] i

vakes [l Foroko Rera 100 [ Bsrcromars Bt -1.55%

Partiollo Yield ve [ET1 o] 1

wais [l P s 2.50% [ [T ———

o=

Market Capitalisation
of 553 billion and
below

Net Debt/Equity Positive Free Cash
' s Flow

Note: The Portfolio Return indicated in the chart does not include dividend income, as opposed to Total Return that is inclusive of Dividend Income.
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Summary (02-11-2023 08:34AM )

Name 4

Geo Energy Res

Chg

-0.005
{-1.69%)

P/L

-646
(-6.45%)

Unrealized PIL & -4,050

PL+
Div

Cost Value

10,013 9,367

INVESTOR-ONE PORTFOLIO

Hock Lian Seng i 3 s =800 5,800 5,000
(-13.79%)

HRnetGroup ; : f 0.005 (0.72%) -1,500
(-9.74%)

Hyphens Pharma 0.005 (1.82%) =1,000

(-8.87%)
JEP Hidgs : : ; 646 (6.45%) 10,013

Kimly : ; : -950 4,000
(-23.75%)

Nordic . . A 200 (5.06%)

Summary ( 02-11-2023 08:34AM )

Closed Positions

Realized Profit  « -2,900
Name#s Proceeds
HG Metal k ; 3,400

InnoTek 5 K e ; 4 800

Transaction (02-11-2023 )

Stock Exchange Rate Amount Dated

JEP Hldgs ; N/A ; 10,013 4 Jul 2023
HG Metal ¥ MN/A . 3,400 13 Mar 2023
InnoTek ; MNIA . 4,800 13 Mar 2023
Geo Energy Res : N/ i 10,013 13 Mar 2023
HRnetGroup ; NIA ; 15,400 16 Feb 2022

Kimly : NIA . 4,000 16 Feb 2022

&
L=

HG Metal ; NIA i 3,750 16 Feb 2022
InnoTek ; MIA a 7,350 16 Feb 2022

Nordic . MNIA i 3,950 16 Feb 2022

2

666668680808

Hyphens Pharma F /A 5 15,000 16 Feb 2022

Hock Lian Seng ; N/A, . 5,800 16 Feb 2022

i

Deposit MN/A 100,000 15 Feb 2022
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Dividend (02-11-2023 )

YTD

TRAILING 12 MONTHS

2022

SGD 5276.70

SGD 5276.70

SGD 2459.20

Stock

Ex-Date

Payable Date

Amt

Amt(SGD)

HRnetGroup

30 Aug 2023

11 Sep 2023

SGD 0.0187

0.0187

Geo Energy Res

28 Aug 2023

06 Sep 2023

SGD 0.0050

0.0050

Nordic

17 Aug 2023

04 Sep 2023

SGD 0.0100

0.0100

Hyphens Pharma

16 Aug 2023

31 Aug 2023

SGD 0.0360

0.0360

Kimly

27 Jun 2023

14 Jul 2023

SGD 0.0056

0.0056

Geo Energy Res

29 May 2023

08 Jun 2023

SGD 0.0050

0.0050

Hyphens Pharma

09 May 2023

24 May 2023

SGD 0.0111

0.0111

Geo Energy Res

08 May 2023

17 May 2023

SGD 0.0400

0.0400

Nordic

07 May 2023

17 May 2023

SGD 0.0091

0.0091

Hock Lian Seng

07 May 2022

19 May 2022

SGD 0.0100

0.0100

HRnetGroup

03 May 2022

12 May 2022

SGD 0.0187

0.0187

Kimly

26 Jan 2022

08 Feb 2022

SGD 0.0112

0.0112

HRnetGroup

28 Aug 2022

06 Sep 2022

SGD 0.0213

0.0213

Nordic

16 Aug 2022

02 Sep 2022

SGD 0.0116

0.0116

Kimly

29 Jun 2022

15 Jul 2022

SGD 0.0056

0.0056

Hyphens Pharma

11 May 2022

25 May 2022

SGD 0.0067

0.0067

InnoTek

10 May 2022

25 May 2022

SGD 0.0200

0.0200

Hock Lian Seng

08 May 2022

20 May 2022

SGD 0.0125

0.0125

HRnetGroup

08 May 2022

18 May 2022

SGD 0.0300

0.0300

Nordic

05 May 2022

17 May 2022

SGD 0.0015

0.0015

Nordic

05 May 2022

17 May 2022

SGD 0.0061

0.0061

HG Metal

05 May 2022

20 May 2022

SGD 0.0400

0.0400

INVESTOR-ONE PORTFOLIO

This portfolio is managed by Investor-One research team, under Sharelnvestor.

Disclaimer:

1. The Investor-One portfolio is aggregated for educational and illustration purposes only. It is curated based on fixed financial parameters as
indicated above. The investor-one team select their stocks solely base on the these fixed parameters. The featured companies are for information
only and does not constitute investment advice.

. The investor-one team is not licensed by any financial authority in Singapore. You should consult your Trading Representative or Financial Advisors
before making any financial decisions.

. Current Price, current value and gain/loss (%) under current portfolio are based on 10 minutes delayed data.
. Purchase Price and Exit Price are based on EOD price.
. The views and opinions expressed does not necessarily reflect those of Sharelnvestor Pte Ltd nor any related companies of Sharelnvestor Pte Ltd.
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5 Investment Checklist Items: Why
They're Crucial to Your Success

Vincent Wong, Investor-One / Mon, Oct 30, 7:00 AM

In Intensive Care Units (ICUs), doctors use checklists to ensure they cover
all aspects of patient care, reducing the risk of complications. Similarly,
pilots before taking off, run through a detailed checklist to guarantee
everything's in order for the flight. If these professionals trust checklists in
life-or-death scenarios, why shouldn't investors, like us, do the same for our
wealth?

Now, think of investing. An ex-colleague once shared a stock tip about a
tech company. Buzz was everywhere. He eagerly invested. But in just a
few months, that stock tanked due to declining business fundamentals.
Reflecting on this, the words of Daniel Kahneman, the Nobel-winning
psychologist, come to mind: "We're generally overconfident in our opinions
and our impressions and judgments.’

continued on next page...
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Mistakes happen, especially when we think we've got it all figured out. A
checklist, though, could be that second pair of eyes we often need. So, why
not dig deeper into how checklists can help us be better investors?

Consistent Framework

Think of your favorite recipe. Without a clear list of ingredients and steps,
you might forget the salt, leading to a bland dish. Similarly, an investing
checklist ensures you analyze all vital components of an investment.

Emotional Buffer

When COVID-19 emerged, the market was crashing. Panic is in the air.
Without a checklist, you might be tempted to sell everything. But with a
systematic approach, you're reminded to assess the long-term viability
and fundamentals of your investments, potentially saving you from rash
decisions to sell your investment prematurely.

On the other hand, It also stops you from making an investment due to
“Fear of Missing Out”(FOMO) like what my ex-colleague did.

Error Minimization

Let's talk about company “G”. It had stellar revenue growth but hidden in its
financial reports was a higher cost for the growth and a higher burn rate.
Without a checklist to review all aspects, crucial details can be missed, and
we know the consequences.

Read Also: Analyst Alert:. Research Reports On SGX Listed REITs & Stocks
(27 Oct)

Dr. Seuss wisely remarked, “There is no one alive who is You'er than

You.” And that is truer than true. We all have our unique perspectives, risk
tolerances, and strategies. However, for fundamental investors, while there's
no one-size-fits-all checklist for investing, there are some fundamental
boxes that most of us should consider ticking. Here are a few examples...

#1 Do | understand the business model? (Circle of Competence)
The concept underscores the importance of investing in what you know.

continued on next page...
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By staying within your realm of knowledge, you can better gauge risks,
understand industry nuances, and predict potential shifts.

A good starting point is to begin with your own professional field. If
you've worked in the shipping sector, you could be more informed of the
freight rate increase and supply-demand inbalance during the pandemic
period, which might enable investors to invest in shipping companies like
Samudera, which performed strongly in the last 3 years.

Warren Buffett once said, "Stick to what you know. The most important
thing is to define what you can do and what you can't do."

#2 Does the business have a sustainable advantage? (Moat)
A company's ‘'moat' is its defensible edge in the marketplace. This could
stem from various sources; just to name a few examples:

- Large grocery retailers like Sheng Siong, for example, can maintain a rapid
inventory turnover and use their scale to negotiate better prices, passing
savings onto customers and making it tough for smaller competitors to
enter the market and match their prices.

- Apple not only has a great Brand but also a superior supply chain system,
allowing the company to earn the majority of the industry's profits.

- Some businesses might have exclusive rights to resources, making it hard
for new entrants to take the market share. For example, exclusive supply

for Limited Rolex models for The Hour Glass and Cortina in Singapore.

Echoing this sentiment, Peter Lynch said, "In business, competition is never
as healthy as total domination.”’

Read Also: The Watch Retailer Is Near Its 52-week low.

#3 Is it run by Honest and Capable Management?

The character and capability of the leadership team can make or break
an investment. No matter how attractive the valuation is, if they are the
management or founders treat the public company like its personal
belongings, investors should not consider making the investment.

continued on next page...
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Integrity ensures transparency, trustworthiness, and willingness to return
value to the shareholders, while competence is about the ability to navigate
challenges and steer the company toward success.

Want to see if a company has a history of giving back to its shareholders?
Take a peek at their past dividend payout ratios.

Next, to get a sense of how well the company's management is using the
money they choose to keep (instead of giving back as dividends), check out
the Return-on-Equity (ROE). It's a good indicator of how effectively they're
putting that money to work.

a common oversight for many retail investors is not digging into
management compensation. Screeners don't usually flag this, so it takes
that extra step of sifting through annual reports. Take a snack company on
SGX, for instance. The management's pay is gobbling up a big chunk of their
profit. That's a real eyebrow-raiser, hinting at possible interest misalignment.

#4 Do | understand the Intrinsic value of the business?
Benjamin Graham’s timeless advice is apt here: "Price is what you pay; value
is what you get."

You wouldn't buy a house just because everyone's talking about it. You'd
want to know its foundation, its location, maybe even its history. Similarly,
the intrinsic value of a business tells you about its core strength, separate
from the buzz of the stock market.

Now, there's no magic wand to find out this value. Instead, experts use
various models to calculate —looking at things like expected dividends,
future cash flows, or even residual income. But here's the catch: these
models are only as good as the assumptions they're based on. One wrong
guess and the estimated value can swing away from the real deal.

On a side note, when you're trying to figure out a stock's real worth, or its
intrinsic value, you'll need something called a discount rate. Think of this as
the returns you could get somewhere safe, like government bonds, which
generally increase when the Feds decide to increase its interest rate.

continued on next page...

Read f
suc(t:a:artrirglz‘er's(:3 :n INVESTOR

IDEAS


https://rebrand.ly/investform
http://rebrand.ly/6bv0m3f

Invest FRIDAY NOVEMBER 03,2023 2
for weekly Inve$t

continued... [5 Investment Checklist [tems: Why They're Crucial to Your Success]

IDEAS

Generally, if the yields of those investments go up, you would need to have a
higher discount rate which lower your investments’ intrinsic value.

Read Also: U.S. Treasury Yields at 16-Year High: What It Means for
Investors

#5 Is the downside minimal? (Margin of Safety)

Imagine walking a tightrope. Would you feel more secure doing so with or
without a safety net below? The concept of "margin of safety” in investing is
just like that safety net. It's the buffer that helps safeqguard your investment
from the unpredictable ups and downs of the market.

Consider this: if you've set your sights on a stock with an intrinsic value of
$60, but you snag it at $40. If you've done your homework correctly with
the calculation of intrinsic value, you've essentially given yourself a $20 per
share safety cushion. That buffer allows for errors in judgment, unexpected
market swings, or any unforeseen events.

Warren Buffett, arguably one of the most successful investors of all time,
often stresses this very principle. He famously said, "The three most
important words in investing are margin of safety.” And here's why he's spot
on: even with the most detailed checklist, we're bound to make mistakes

or overlook certain factors. Why? Because the world, by its very nature, is
full of uncertainties and unforeseen events. We're all prone to errors, and
sometimes external factors beyond our control can affect our investments.

That's where the margin of safety comes into play. It's our built-in buffer
against these unknowns. It helps ensure that even when things don't go
exactly as planned, our initial investment is shielded to some extent. This
strategy isn't about guaranteeing profits, but rather about preserving capital.
After all, in the world of investing, sometimes the best offense is a good
defense. And having that safety margin? It's one of the best defensive
moves you can make.

By understanding and internalizing these principles, we arm ourselves with
a solid foundation to navigate the turbulent waters of the investment world.
Always remember, that knowledge is your compass. Safe investing!
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INSIDER

TOP SIGNIFICANT

INSIDER ACTIVITY

Direct Deemed Total Direct Deemed Total % Held ©

30 Oct 2023 Trendlines The Bank of New York Mellon [SSH] S/U 8,868 8,868 0.086 118,735 118,735 12.370
(01 Nov 2023)

30 Oct 2023 Trendlines The Bank of New York Mellon Corporation [SSH] S/U 8,868 8,868 0.086 118,735 118,735 12.370
(01 Nov 2023)

27 Oct 2023 ASL Marine? Fidelity Management & Research Company LLC [SSH] S/U -45,731 -45,731 0.053

(01 Nov 2023)

27 Oct 2023 ASL Marine® FMR LLC [SSH] S/U -51,622 -51,622 0.053

(07 Nov 2023)

27 Oct 2023 ASL Marine® Abigail P. Johnson [SSH] S/U -51,522 -51,522 0.053

(07 Nov 2023)

27 Oct 2023 ASL Marine® Fidelity Puritan Trust [SSH] S/U -45,731 -45,731 0.053

(01 Nov 2023)

01 Nov 2023 Wing Tai Cheng Wai Keung [Dir/CEQ] S/U 50 50 1.330 214 466,733 466,948 61.320
(01 Nov 2023)

31 Oct 2023 Heatec Jietong Soon Yeow Kwee Johnny [Dir/CEQ] S/U -40 -40 0.028 22,113 4,816 26,930 13.150
(01 Nov 2023)

31 Oct 2023 Heatec Jietong Soon Yeow Kwee Johnny [Dir/CEQ] S/U -42 -42 0.028 22,071 4,816 26,887 13.130
(01 Nov 2023)

27 Oct 2023 Heatec Jietong Soon Yeow Kwee Johnny [Dir/CEQ] S/U -120 -120 0.027 22,154 4,816 26,970 13.170
(01 Nov 2023)

24 Oct 2023 FuYu Morgan Stanley [SSH] S/U 224,393 224,393 0.120 224,393 224,393 29.643
(01 Nov 2023)

24 Oct 2023 Fu Yu Morgan Stanley & Co. International plc [SSH] S/U 12 224,393 224,393 0.120 224,393 224,393 29.643
(01 Nov 2023)

24 Oct 2023 FuYu Morgan Stanley Investments (UK) [SSH] S/U 224,393 224,393 0.120 224,393 224,393 29.643
(07 Nov 2023)

24 Oct 2023 Fu Yu Morgan Stanley International Limited [SSH] S/U 224,393 224,393 0.120 224,393 224,393 29.643
(01 Nov 2023)

24 Oct 2023 FuYu Morgan Stanley International Holdings Inc [SSH] S/U 224,393 224,393 0.120 224,393 224,393 29.643
(01 Nov 2023)

30 Oct 2023 AEM SGD abrdn Holdings Limited [SSH] S/U 383 383 3.490 28,153 28,153 9.114
(01 Nov 2023)

30 Oct 2023 AEM SGD abrdn Asia Limited [SSH] S/U 383 383 3.490 15615 15,615 5.055
(01 Nov 2023)

30 Oct 2023 ST Group Food Chen Khai Voon [SSH] S/U 500 500 0.160 19,932 19,932 8.120
(01 Nov 2023)

30 Oct 2023 ST Group Food Chen Khai Voon [SSH] S/U 595 595 0.160 20,527 20,527 8.360
(01 Nov 2023)

30 Oct 2023 Union Steel LIAN BEE METAL PTE LTD [SSH] S/U 21 21 1.050 2,112 2,112 5.360
(01 Nov 2023)

31 Oct 2023 SHS NG HAN KOK [Dir/CEQ] S/U -1,500 -1,500 0.129 26,568 92,647 119,215 19.530
(07 Nov 2023)

24 0ct 2023 FuYu Mitsubishi URJ Financial Group, Inc. [SSH] S/U 224,393 224,393 0.120 224,393 224,393 29.643
(01 Nov 2023)

27 Oct 2023 IHH EMPLOYEES PROVIDENT FUND BOARD [SSH] S/U -1,996 -1,996 1.710 944,769 944,769 10.727
(01 Nov 2023)

30 Oct 2023 Meta Health BLUE OCEAN CAPITAL PARTNERS PTE LTD [SSH] S/U 8,000 8,000 0.006 99,470 99,470 9.650
(01 Nov 2023)

30 Oct 2023 Meta Health Estate of Mr Lin Wee, Daniel [SSH] S/U 8,000 8,000 0.006 99,470 99,470 9.650
(01 Nov 2023)

30 Oct 2023 Meta Health BLUE OCEAN CAPITAL PARTNERS PTE LTD [SSH] S/U 81,970 81,970 0.006 91,470 91,470 8.870
(01 Nov 2023)

30 Oct 2023 Meta Health Estate of Mr Lin Wee, Daniel [SSH] S/U 81,970 81,970 0.006 91,470 91,470 8.870
(01 Nov 2023)

31 Oct 2023 LHT YAP MUI KEE [Dir/CEO] S/U 3 3 0.820 0.820 8,799 8,799 16.525
(31 Oct 2023)

31 Oct 2023 Wilmar Intl Kuok Khoon Hong [Dir/CEQ] S/U 309 309 3.560 2,995 837,375 840,370 13.460
(37 Oct 2023)

27 Oct 2023 Pegasus SPAC The Bank of New York Mellon [SSH] S/U -1,902 -1,902 4.790

(31 0ct 2023)

Access WebPro to view more insider trades

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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IiP jun yuan Jun Yuan's insights, strategies, and

advice have helped many on their
investing journey. The road to
retirement can be challenging, but it

Definitely a must-read for investors looking to build a passive income flow!

Especially in a Singapore context, REITs is one of the many way to build up your recurring
income as a means for retirement. in his book. Jun Yuan gives a very thorough views on

REITs. From the basic concepts and understandings of REITs, to the valuing / monitoring /
investing aspects of REITs, Jun Yuan has not only provide the simple ABCs (what), but also
the application (how) to provide some action-able considerations.

Personally, | also like the “"bonus chapters” that help to address some FAQs, and provide
an overview of the various REITs that are listed on SGX.

Highly recommended to those who want to kick-start his or her journey in bullding up a

doesnt have to be. This book is your
roadmap to financial security in
retirement. Learn how to build a robust
REIT portfolio that will provide you with

REIT-irement portfolio.

a cushion during your retirement years,
so you can finally bid farewell to
financial worries.

- Dan Chang C S, Trading Representative. PhillipCapital

I am specially honoured to help Jun Yuan with this review as he is definitely more savwwy in
REITs investing than me.

At first glance. the book provides a comprehensive and well-structured framework to share
on various aspects of REIT investing, guiding readers throughout the whole process of
buying and monitoring REITS,

Upon further reading. 1 am amazed of the value offered in this book such as the S-point
criteria checklist. practical case studies and 4 potential red flags we should take note of,

$29.00

Delivered via registered mail

- James Yeo, Founder @ InvestKaki.com

Terms and Conditions

«For registered mail purchase, the buyer must ensure their mailing address is correct
Sharelnvestor will not be liable for any book that is mailed to the wrong address or the loss
of any books in the mail

=By purchasing the book, the buyer agrees to the Terms & Conditions stated.


https://notice.shareinvestor.com/email/20230906_Building_Your_REIT-irement-Portfolio/EDM/resgistered-mail/index.html
https://www.shareinvestor.com/sg/events/signup?id=1525
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Delivers Distributable Income Of S$52 Million

TEC For 3Q 2023, 3.6% Higher Than 2Q 2023.

Real Estate Investment Trust

Suntec REIT reports distributable income of S$52.0 million for the period from 1 July
to 30 September 2023, 3.6% higher than the quarter ended 30 June 2023, but 13.3%
lower than the quarter ended 30 September 2022. Distribution per unit of 1.793 cents
to unitholders for 3Q 23 was 3.1% higher than 2Q 23 but 14.0% lower year-on-year.

http://suntecreit.listedcompany.com/news.html/id/2463213

Achieves Strong FY23 Results
On Robust Operating Performance & Strategic Portfolio Re-
Constitution.

2H23 distribution per Unit of 6.020 Singapore cents brings total DPU for FY23 to 12.150
Singaporecents. Improved FY23 gross revenue and NPI from higher gross rental and atrium
income. Robust operating performance with higher committed occupancies, improved
rental reversions and sustained growth in tenants’ sales. Stable portfolio valuation with
no change in valuation capitalisation rates. Making progress on the sustainability journey
and Environmental, Social, and Governance.

http://fraserscentrepointtrust.listedcompany.com/news.html/id/2463386

L.

TRUST

lif Secures Renewal With 1100 Peachtree Anchor
Manulite Tenant Kilpatrick Townsend, Negotiations With Lenders In

US REIT Progress.

Tenant currently leases about a third of the net lettable area at 1100 Peachtree. Follows
landlord’s commitment for a ~USS$18 million ground floor renovation, with completion expected

in 2025. Discussions with lenders ongoing.

http://manulifeusreit.listedcompany.com/news.html/id/2463129

Partners With KEZAD Communities To Explore Strategic

Opportunities In Middle East Specialised Accommodation Business.

Centurion Corporation Limited has entered into a strategic partnership with Abu Dhabi'’s largest
end-to-end staff accommodation owner and solutions provider, KEZAD Communities, a part

of KEZAD Group, to explore collaboration in the business of providing accommodation for
employees and students in the Middle East region. The partnership has been materialised with
the signing of a memorandum of understanding by Mr. Eissa Al Hemeiri Director, Communities
Services & Operations, KEZAD Communities and Mr. Kelvin Teo, Chief Operating Officer of
Centurion Corporation on 21 October 2023 in Dubai.

http://centurion.listedcompany.com/news.html/id/2463232

MiQ

Records 1Q FY2024 Profit Before Tax Of

Steady Revenue Growth But Costs Pressures Persist.

The Group reported SS$37.7 million revenue for THFY2024, an increase of 8% year-on-year
compared to S$34.9 million in THFY2023. Within the Group’s revenue, Bahrain increased by
32.4% to S$18.4 million during the period. Operations in Singapore, however, experienced a
decrease for the period. This was partly affected by the final stages of relocation process
from Pandan Property, while the remainder can be ascribed to the natural ebb and flow
of order conversion. Inquiries remain robust and the Group are committed to optimizing
utilization wherever possible.

http://mtg.listedcompany.com/news.html/id/2463434

S$4.7 Million, Net Profit After Tax Of S$2.8 Million.

Revenue rose 38.5% year-on-year to S$31.0 million, propelled by accelerated boat-building
activities. 1Q FY2024 NPAT of S$2.8 million is 158.0% higher compared to S$1.1 million in

1Q FY2023. 5 new built-to-order boats secured during the period in review; net order book of
S$148.8 million as at 30 September 2023, compared to S$159.4 million as at 30 June 2023.

http://grandbanks.listedcompany.com/news.html/id/2463341

Gnturion

Centurion Corporation Limited

GRAND EANKS

ANNOUNCEMENTS


http://fraserscentrepointtrust.listedcompany.com/news.html/id/2463386
http://manulifeusreit.listedcompany.com/news.html/id/2463129
http://mtq.listedcompany.com/news.html/id/2463434
http://suntecreit.listedcompany.com/news.html/id/2463213
http://centurion.listedcompany.com/news.html/id/2463232
http://grandbanks.listedcompany.com/news.html/id/2463341
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https://notice.shareinvestor.com/email/2019_MoneySmart/index.html
https://notice.shareinvestor.com/email/2019_OneUpWallStreet/index.html
https://notice.shareinvestor.com/email/2019_TheCompleteTurtleTrader/index.html
https://notice.shareinvestor.com/email/2016_SmallChange2/index.html
https://notice.shareinvestor.com/email/2020_FinancialFreedomBlueprint/index.html
https://notice.shareinvestor.com/email/2020_DividendGrowthMachine/index.html
https://www.shareinvestor.com/sg/bookstore.html
https://notice.shareinvestor.com/email/20230906_Building_Your_REIT-irement-Portfolio/EDM/resgistered-mail/index.html

Inve t FRIDAY NOVEMBER 03, 2023

ROGER MONTGOMERY

VALUtoABLE

B0W T0 VALEE TRE BEST STOCKS AN
BUY THEM FOR LESS THAN THEY'RE WORTH

LORNA TAN

Click on book
for more details

RETIRE
SMART

OVER 1.5 MILLION COPIES 501D

A RANDOM /
WALK DOWN
Wall Strezt

L The
‘\"‘m\(' Ttz Time-Tested

= Strategy
Ta— i
. ‘ Sucdewnlal
IIIIII

BURTON G. MALKIEL
ECoXPATKCVINRY A e W PR AR

BOOKS


https://notice.shareinvestor.com/email/2019_RandomWalkWallStreet/index.html
https://notice.shareinvestor.com/email/20150925_ShowMeTheMoney2/index.html
https://notice.shareinvestor.com/email/2015_Book_ShowMeTheMoney3/index.html
https://notice.shareinvestor.com/email/20161014_ShowMeTheMoney4/index.html
https://notice.shareinvestor.com/email/2015_Book_Valueable/index.html
https://notice.shareinvestor.com/email/2018_retiresmart/index.html
https://www.shareinvestor.com/sg/bookstore.html

